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Foreword

ADVISOR Enterprise is a Training Management System that drives training efficiency by (a) aligning current and
future training activities to operational requirements to identify gaps, duplications and training with minimal
value; (b) forecasting and comparing the costs of viable delivery options; (c) uncovering cost drivers; and (d)
improving resource allocation. ADVISOR is built around the ADDIE model with the added flexibility of starting the
analysis at any level. ADVISOR is made up of the following modules that can be used separately or in any
combination.

Needs Assess: To find out “the cause of the problem and potential solutions”. Provides a step by step approach
Assessment for understanding a problem before selecting the solution —in other words, before assuming that training
is needed. Needs Assessment provides an audit trail and serves as the foundation for decisions by zeroing
in on the source of the problem, identifying solutions that can produce the desired level of productivity,

and highlighting actions that will generate the greatest impact. [Scope and Needs Assessment].

Training Analysis: To find out “who needs to be trained, on what and why”. Provides a step by step approach for

Analysis conducting Training Needs Analysis (TNA) or Training Systems Requirements Analysis (TSRA) to identify
training needed by each job, position and employee to perform duties to the desired standard under the
prescribed conditions. Four approaches may be used to conduct training analysis, namely Mission,
System, Competency or Job. [Mission Analysis, Competency Analysis, System Analysis, Job Task Analysis,
Knowledge/Skill Gap Analysis and Training Requirements Analysis].

Design: To find out “what is the most effective and economical way to deliver training”. Provides a step
by step approach for conducting Training Media Analysis (TMA) or Option Analysis to identify the most
cost effective strategy for the delivery of training and generates Training Plans. The analysis takes into
account limitations, instructional design requirements, upfront and recurring costs over training program
life as well as risks associated with the introduction of new technology. [Media Analysis, Cost Analysis and
Training Plans].

Fidelity Develop: To find out the “fidelity requirements of training devices”. Provides a step by step approach for

Analysis assessing the functional requirements of trainers and simulators based on training needs and
performance objectives. It identifies visual, tactile, olfactory, affective and auditory sensory cues needed
to practice tasks, within realistic environments, under preset conditions to attain the desired level of
competency. In addition, ADVISOR takes into account elements within the virtual world and how users
interact with each.

Resource Implementation: To find out “how much money and resources are needed”. Compiles and analyzes
Management missions/goals, competencies, systems, jobs, tasks, training requirements, courses, activities, costs,
personnel and resources to generate concise, up to date and actionable reports. The reports provide
insight on planned training activities for any time period; training requirements for each job/employee;
budget, personnel and resource requirements, training impact as well as how to drive training
effectiveness and efficiency by leveraging technology, improving resource allocation and identifying gaps,
duplications and unwarranted training. [Forecast and Optimize Training Budgets, Personnel and
Resources].

Project Implementation: To find out “how training should be implemented”. Provides a step by step approach
Management for planning a project and tracking progress in real time. This includes the setup of phases and tasks,
dependencies and constraints, timelines as well as the assignment of personnel and resources needed to
complete. Moreover, ADVISOR tracks progress by comparing hours worked and money spent on each
task to project plan, to anticipate delays, facilitate the implementation of corrective measures, and keep

projects on-time and within budget. [Develop Project Plans and Track Progress].
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Performance Evaluation: To find out “how training impacts performance and organizational goals”. Provides a step by
Analysis step approach for improving performance by zeroing in on the source of the problem and identifying
solutions that can produce the desired level of productivity. Moreover, ADVISOR highlights actions that
will generate the greatest impact by assessing the feasibility of implementing plausible solutions as well
as forecasting the costs, benefits and Return on Investment (ROI) of each intervention. [Performance

Gap Analysis, Root Cause Analysis and Cost Benefit Analysis].

Training Life Manage: To “continually uncover venues to drive training effectiveness & efficiency”. Maintains training
Cycle effectiveness and efficiency over time by continually assessing the impact of changes to missions, jobs,
Management tasks, systems, policies, technologies, throughput, and so forth on training content and activities; as well

as budget, personnel and resource requirements. This is attained through a digital-twin model that
continually aligns training activities to operational requirements to identify gaps, duplications and training
with minimal value. Results (personnel/resource requirements for any time period; cost drivers;
bottlenecks and deficiencies) are quickly and concisely communicated through dashboards. Actions that
drive training effectiveness and efficiency are also highlighted.
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Chapter 1: Setup Projects

1.1 Introduction

ADVISOR is highly flexible. Based on project requirements, the analysis may start by examining Missions/
Goals, Systems, Competencies, Jobs or combinations. The current guide presents a step-by-step process
to assist analysts in conducting System/Competency Analysis, Job Analysis and Task Analysis to identify
training requirements. Separate Step-by-Step Guides are available for conducting Mission Analysis and
Job Analysis, and therefore they will not be explicitly covered in this Step by Step Guide. For details, on
all analysis covered by ADVISOR Enterprise, please refer to the Training Analysis User Guide. For info on
basic functionality and how to configure ADVISOR in line with needs, please refer to the Configure
ADVISOR Step by Step or User Guide. Remember that context sensitive help for each screen is also
available by clicking on [Help].

1.2 Setup New Projects

To create a new Project:

Step 1: Click on the FtProjects folder.

Step 2: Click [Add].

Step 3: Input the Project Title, Contact Name and other info. Data required by ADVISOR is identified by a
red asterisk (*). Of course, the more data you provide, the better the results.

|

+Add & Save 3 Copy x Delete & Merge % Diverge 1} Notes H Print tUp <« Restore ? Help & Logout
Path _Training Analysis b Projects
Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
=iTraining Analysis Projects &
— Project Title”

Reference Code

Contact Name
Phone Number »
E-mail N

Base Currency” US Doliar
Date Format* da/mmiyyyy

Area Measurement Unit" square foot

LA N SRK

Training Analysis Model [ select ]

Set Knowledge/Skill Current Level to Blank

Cascade Knowledge/Skills v

Sync POs/EOs with Tasks/Sub Tasks

Client* [select] v

Status’ Public (all users) v

Sub Divide* No v

Sequence 0

Click and complete next tab, if applicable; then click the Save button on the top left to save.
« »
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Step 4: Click on the [Defaults] tab to specify Annual Productive days, Working Hours per Day and Fringe

Benefits Factor for the project. The Currency and Inflation Rate will cascade & from the Client
settings.

Implication: Inflation Rates can greatly impact the cost of courses over time. Other default values
can improve consistency and save time by populating the corresponding values in new projects.

4

+Add & Save 8 Copy = Delete je 4 Diverge 0 Notes H Print 1 Up « Restore ? Help & Logout

Path _Training Analysis b Projects
Dashboard Setup Scope Analyze
5 Training Analysis Projects =

Annual Productive Days 230
Working Hours perDay 75
Fringe Benefits Factor [%] 0 % N

Click and complete next tab, if applicable; then click the Save button on the top left to save.

Develop

Implement Evaluate Solutions Documents Reports Personalize

@« »

Step 5: Click [Save], once all relevant fields are filled out to create the project.

Notes:

» To edit an existing project, click on the ["}Projects folder then click on the project’s name. Make the
required changes and click [Save].

» You may also share your analysis with colleagues (i.e., Users assigned to the same Client) by clicking
on the [Sharing] tab, placing checkmarks next to their names and clicking [Save].
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1.3 Configure Projects

To preserve consistency, all configurations including data to be collected, analysis to be conducted, and
reports to be generated cascade from Client’s Setup (See Configure ADVISOR Step-by-Step Guide). To
modify the configuration for a specific project:

Step 1: Click on the @ icon to turn the cascade off @.

+Add & Save 8 Copy x Delete © Merge % Diverge 1 Notes B Print T Up < Restore ? Help & Logout

Path Training Analysis » Project Management Office

Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis il Project Management Office &Y0
¥ [MProjects Contact Info efaults Analysis Required S y Arct
B
Project Title* Project Management Office
Reference Code Project 020
Contact Name John Green
Phone Number 514-909-8877
E-mail J.green@bnhexpertsoft.com
Base Currency" Canadian Dollar ve
Date Format* mmvadlyyyy veo
Area Measurement Unit* square foot ve
Training Analysis Model DIF (Ohio State SCID) vo
Set Knowledge/Skill Current Level to Blank |4/ o
Cascade Knowledge/Skills o4 o
Sync POS/EOs with Tasks/Sub Tasks 4 °
Report To [ select ] v
Client* Corporate Training Division N <]
Status® Public (users for client) v —
Manager* Administrator v
Sub Divide* No v
Sequence 100

Click and complete next tab, if applicable; then click the Save button on the top left to save.

« »
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To specify data to be collected and analysis to be performed click on the [Analysis Required] tab.

Place checkmarks next to the required items. Deselected items indicate that the analysis and data
are not needed. ADVISOR will, in-turn, automatically hide nodes, tabs and fields that are no longer
required, streamline data collection and reduce time required to conduct the analysis — a very
effective way to configure ADVISOR in line with your needs.

Click [Save] to save the configuration.

For example, if System Analysis is needed but Mission/Goal Analysis is not required, all
checkmarks for Mission/Goal related items should be removed, as shown below. You may, of
course, reinstate the Mission Analysis requirement at any time, as the need arises.

& Save & Copy * Delete roe # Diverge 1 Notes.  Print Up % Restore 2 Help. 5 Logout

Setup Scope Analyze

.

@_Project Management Office

Design

Analysis Required _ Sharing _ Archi

= Anayze @ O
B[ | Mission/Goal Analysis @ @

Task Analysis @ @
Knouledge/Skils
Job Alds
Policies
Toois
Performance Objectives @ @
Training Requirements (Knowledge/Skills & Knowedg.
Job Aids
Policies
Toois
Training @ @
| | Leaming Objectives @ @
Test items
Manage Leaming Objectives
Mission Reports @ @
Task List Report
Performance Objective Report
Training Requirements Analysis
Align Tasks with Goals
Export Mission Task Tree
Export Mission PO/EQ Tree
Mission Analysis Report
Mission Requirements Report

=/ SystemCompetency Analysis @ @

=v

L

4
/| Policies
v

Tasks @ ©
Knowiedge/Skils
Job Aids

Tools

RNH

EXPERT SOFTWARE

Implication: All fields corresponding to
hidden for this project. This will in-turn streamline the interface and reduce time needed to

conduct the analysis.

data and analysis not required will be automatically
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1.4 Setup Project Segments

You may also subdivide and organize the data under each project in various segments, if needed. For
example, if the project entails the assessment of training requirements within multiple units,
departments, commands or platforms, you may subdivide the project into segments and sub segments,
and organize the data accordingly. For example, a corporation (project) may be divided into the following
segments: Sales, Marketing, IT, Operations and so forth. A Navy (project) may be subdivided into the
following segments: Frigates, Joint Support Ships, Ice Breakers, Submarines, and so forth. Moreover, the
impact of missions/goals within each segment (unit) on parent (organization) can also be defined.

Joint Support

: Icebreakers Submarines
Ships

Frigates
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To set-up a Segment for a Project:

Step 1: Click on the ["*Segments folder under the ["Projects folder.

Step 2: Click [Add].

Step 3: Input the Project (Segment) Title, Contact Name and other information.
Step 4: Click [Save] to create the Segment.

L A 4

+Add Save ¥ Copy x Delete + Merge < Diverge 11 Notes H Print 1 Up <« Restore ? Help [ Logout
Path Training Analysis b Project Management Office  Segments

Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Personalize
5 Training Analysis Segments. &
v [Projects Contact Info alysis R ! Sharing
¥ [ Project Management Office

» [)Mission Analysis Project Title* Quality Control Department
> BJob Analysts Reference Code Project 021
Jobs Proficiency Levels

» 3Team Knowledge/Skills Contact Name Red Steel

[3Project References

Phone Number 514-707-7272
F3Acronyms
» IIProject Knowledge/Skills Attributes E-mail rsteel@bnhexpertsoft.com
> EipPrmject Reports Base Currency” US Dollar \ g — v 9
< Search N

- T, |02t Fomar aammyy e
Area Measurement Unit* square foot v o
Training Analysis Model [ select] v 0
Set Knowledge/Skill Current Level to Blank O
Cascade Knowledge/Skills i |
Sync POS/EOs with Tasks/Sub Tasks [
Status™ Public (all users) v
Sub Divide™ No v
Sequence 0

Click and complete next tab, if applicable; then click the Save button on the top left to save.
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Chapter 2: Setup Systems/Competencies

2.1 Overview

Systems

Job requirements in many cases are directly related to the Systems that individuals operate and maintain.
For example, the Tasks, as well as Knowledge/Skill requirements for heavy equipment, truck and forklift
drivers and technicians are highly dependent on those vehicles. The same is true for aircraft pilots and
technicians, crew onboard ships, and so forth. If multiple jobs operate the same Communication System,
for example, we can preserve consistency, drive efficiency and maintain alignment with future system
updates by defining the Tasks and Knowledge/Skill requirements once (under the Communication System)
and assign them to relevant Jobs. In other words, if Job performance is highly dependent on Systems or
Sub Systems, and multiple Jobs operate or maintain the same System or Sub System, then the Systems
based analysis approach will yield the best results.

Competencies

Competencies are defined as the ability to perform a particular function successfully. Competencies can
be core/behavioral (such as, dependability, reliability, team work or problem solving, etc.); or technical —
i.e., domain specific. Technical competencies for project managers, may include Time Management, Cost
Management, Oral/Written Communication, and so forth. Each technical competency can be further
divided into observable/measurable behaviors (indicators of competence), and each Job level will be
expected to demonstrate a specific competence level. Since multiple jobs within an organization will most
likely require similar competencies, we can preserve consistency, drive efficiency and quickly identify
competencies needed to advance to the next level or change jobs by defining the behaviors (equivalent
to Tasks with Standards) once (under each competency) and assign them to relevant Jobs.
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Since the core requirements for Systems and Competencies are similar, the same ADVISOR functions are
used to analyze both by allowing users to change the taxonomy as follows:

To modify the ADVISOR taxonomy (between System and Competency):

Step 1: Click on the Personalize Tab.

Step 2: Click H Preferences node under the [ tPersonalize folder.

Step 3: Select English (Corporate) or English (Government) to switch taxonomy to Competency. Other

options will default to System.
Step 4: Click [Save].

N 4

+Add Save

Path Personaize b Fraferences

¥ Copy x Delete o Merge ¢ Diverge  (INotes  HPrint Up <. Restore 2 Help

Dashboard Setup Analyze Design Develop Implement Evaluate
"I Personalize Preferences
4 BlPreferences Password  Opfic ] I ccupation  Work Hours  Retire t vilege
4 _1 Classification
] Skills User Login® justinbahlisbnh

Solutions Documents Reports Personalize

| Attributes e rmaress .
Courses
" Calendar Confirm Password"
EiActivities Previous Login (YYYY-MM-DD GMT) 2020-06-29 10:32:58
Time Sheets

Previous Login IP 64.179.210.80

Previous Failed Login (YYYY-MM-DD GMT) 2020-02-20 13:05:28

Previous Failed Login IP 64.179.210.80

Failed Login Count 0

Email Address™ justin.bahlis@bnhexpertsoft com

Phone Number

Location

Language* English (Govemment)

Click and complete next tab, if applicable; then click the S English (Default)

English (Corporate)
English (Government)
English (Canadian Department of National Defence)
English (UK Ministry of Defence)
English (US Department of Defense)
English (First Edition)

» Toavoid redundancy, the remainder of this Step by Step guide will illustrate how Competency Analysis

is conducted.
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To define a competency:

Step 5: Click on the [ tCompetencies folder, under the [Analyze] Tab.

Step 6: Click [Add].

Step 7: Input the Competency Title, a brief overview as well as other relevant data.
Step 8: Click [Save] to create the competency.

88 o

© Merge

+Add & Save 8 Copy 2 Notes
Path _Training Analysis » Project Management Office b Competencies

Dashboard Setup Scope Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis Competencies
v [MProjects Competency Employees

v (1 Project Management Office
» [2Mission Analysis Competency* Leadership
iCompetencies | Reference Code Lot
e /» Job Analysis
Jobs Proficiency Levels Competency Abbreviation Lead
>

% Diverge

REmec s Status* Public
» [3Team Knowledge/Skills
» E3Project Job Aids Limit Access to Client* No

JProject Policies Provide guidance, direction, control and management

1Project Tools

[Project References

F2Acronyms
» E2Project Knowledge/Skills Attributes
» =Project Reports

Overview

Search Context
» Segments

Experience in project management & managing small. medium and large groups of employees.

Experience/Assignments
PMCDO Certificate

Certifications

Sequence 100

Sub Divide™ No v

Click and complete next tab, if applicable; then click the Save button on the top left to save

> To identify which employees require the Competency, click the [Employees] Tab, place checkmarks
next to the desired employees and click [Save]. The list of employees is comprised of both User
Accounts and Project Accounts that are classified as employees of the Client. Once the analysis is
complete Training Requirements for Each Employee report can be generated under the [Reports] tab.

> Subdivide Competencies: Competencies can be divided into Competency Areas. For example,
Leadership Competency can be further divided into the following Areas: Decisiveness, Developing
Others, Team Building, etc.

RN 9|Page
EXPERT SOFTWARE www.bnhexpertsoft.com
Copyright © BNH Expert Software Inc.



ﬁ ADVISOR System/Competency Analysis Step by Step Guide
" ENTERPRISE

Plan better..Achieve more!

2.2 Setup System/Competency Tasks

To create a new task (behavior):

Step 1: Click on the ["*Tasks folder under the H (competency) node or H (competency area) node.

Step 2: Click [Add].

Step 3: Input the Task Title, Standard, Difficulty, Importance, Frequency, Proficiency as well as other
attributes.

Step 4: Next, click on the [Conditions], [Cues] and [Safety] tabs and complete.

Step 5: Click [Save] to create task.

+Add & Save 13 Copy x Delete * Merge % Diverge (1 Notes # Print Tt Up « Restore ? Help X Logout

Path Training Analysis b Project Management Office b Leadership b Se! Targets & Goals

Dashboard Setup Scope Analyze Design Develop Implement Evaluate Solutions Documents J s sonaliz
=1 Training Analysis [l Set Targets & Goals ] Yo
v [Projects Attributes  Conditio: es Safety Jobs Meta Tags
v [ Project Management Office e
» )Mission Analysis [ Tamets & ous
) Competencies Task Title*
Leadership
1 [ Tasks
I / ) Performance Objectives Reference Code ]
Manage Leaming Objectives i T S =

» [=ICompetency Reports

Import Competency Tasks Clear, concise and easily communicated objectives that lead to desired outcomes.

» i1Job Analysis Standards
Jobs Proficiency Levels
» IProject Tasks
» [3Team Knowledge/Skills Task Classification Individual v
» FIProject Job Aids
M Project Policies Objective Classification Core v
FProject Tools Task Difficulty Medium v
F)Project References
I Acronyms Task Importance High o
» [Project Knowledge/Skills Attributes. Task Frequency Medium v
» IProject Reports
Search Task Level of Proficiency Skilled v
» )Segments Task Proficiency Code

Task Requires Immediate Action No
Task Includes Sequential Steps ~ Yes
Task Requires Reference Guide No
Entry Level Can Perform Task No

% of Individuals Performing Task Medium to High

<] 1<) Lef l¢f le] |«

Time Spent Performing Task ~ Medium

Point of Contact

Revision Date 07/01/2020 )

Notes:

> Based on Task’s Difficulty, Importance and Frequency (DIF), Task Pr|or|ty and Training Requirements

are determined and presented under the ! Training node under each . (task). You may of course,
override system's recommendations.

> Sub Divide Tasks: A Task can also be divided into Sub Tasks, Steps and Sub Steps. Each Task can only
be assigned as a single unit (including all Sub Tasks) to a single Competency. In other words, if a Task
is divided into Sub Task A and Sub Task B, you cannot assign Sub Task A to Leadership Competency for
example, and Sub Task B to General Competency.

> Search. To facilitate the analysis, a [Search] tab is presented on the ["}Tasks folder. You can search
for Tasks by Mission, System, Competency, Job or Keyword. To copy, place checkmarks next to the
desired Tasks and click [Save]. All Sub Tasks as well as Knowledge and Skills associated with the
selected Task are also copied.

> If References have been defined under the F?Project References folder (Chapter 6 of Training
Analysis User Guide), a [Reference] tab will also appear after the [Safety] tab. Click the [References]
Tab, select References and click [Save] to link Tasks to specific mandate, requirement, manual, etc.,
and in-turn document the reasoning behind the Task.
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2.3 Identify Knowledge, Skills and Attitudes (KSAs)

To identify knowledge, skills and attitudes needed to perform the Task to the desired level:

Step 1: Click on the [tKnowledge/Skills folder under the O (task).

Step 2: Click [Add].

Step 3: Input the Knowledge, Skill or Attitude title, Learning Outcome, Classification and Knowledge/Skill
Level.

Step 4: Click [Save] to create.

v U

+Add & Save 1 Copy x Delete  Merge % Diverge 0 Notes H Print T Up < Restore ? Help & Logout

Path Training Analysis » Project Management Office b Leadership b Set Targets & Goals b Knowledge/Skils

Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis Knowledge/Skills
v [Projects Knowledge/Skill M.

¥ [ Project Management Office

Describe key elements of a goal

» [2)Mission Analysis
v [3Competencies Title*
v [ Leadership
v [Tasks ~ 4
v [ Set Targets & Goals Reference Code KSA 105 N
r ‘ Learning Outcome®  Knowledge v
/ F2Job Aids Classification Fact v
)Policies

Knowledge/Skill Level Skilled v
[ Tools

) Performance Objectives Sequence 0 -
Manage Leamning Objectives
» =5Competency Reports Click and complete next tab, if applicable; then click the Save button on the top left to save.
&> Import Competency Tasks « ’)
» 2 Competency Area
2Job Analysis
Jobs Proficiency Levels
» [Project Tasks
» 3Team Knowledge/Skills
» PProject Job Aids
) Project Policies
[Project Tools
FProject References
I Acronyms
» M Project Knowledge/Skills Attributes
» ZIProject Reports.
< Search
» ")Segments

>

Notes:

> ldentifying knowledge, skill and attitude requirements for each Task will greatly simplify the process
of uncovering knowledge/skill gaps — i.e., training needed.

> Each time a Knowledge, Skill or Attitude is added, they are automatically compiled under the [} Team
Knowledge/Skills folders.

» To minimize duplication, in lieu of adding knowledge or skills, user may review Knowledge, Skills or
Attitudes under F?Team Knowledge/Skills folder by clicking on the [Select] tab under [ Knowledge/
Skills folder, placing checkmark next to the required Knowledge/Skills and clicking [Save] to add under
the Task.
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2.4 Define Job Aids, Policies and Tools

Job Aids

To identify job aids needed to perform Tasks:

Step 1: Click on the ["tob Aids folder.

Step 2: Click [Add].

Step 3: Input the job aid title, description and other required information.
Step 4: Click [Save].

g 9

+Add & Save 1 Copy x Delete * Merge < Diverge [ Notes H Print tUp <« Restore ? Help Logout
Path _Training Analysis b Project Management Office b Leadership b Developing Others b Set Course of Action b Job Aids
Dashboard Scope Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis Job Aids
Vizlah oo 2021 Financial Forecasts and Upcoming Trends
v [ Project Management Office 4
» I)Mission Analysis Title*
v [2Competencies
v []Leadership N
» Tasks Reference Code Job Aid 252 .
™ Performance Objectives
~1 Manage Learning Objectives Eeoce L L]

» =1Competency Reports
{l hy hy I
iy ‘Competency Tasks Click the Save button on the top left to save

» £ Competency Area e« »
» [ Set Goals
¥ [ Developing Others
v [ Tasks
¥ [} Set Course of Action

Training
22 Knowledge/Skills
Bloonics
C— / Policies
2 Tools

[=2Performance Objectives
Manage Leaming Objectives
» 3 Competency Reports
“>Import Competency Tasks

Note:

» Similar to Knowledge/Skills, each time a Job Aid is added, they are automatically compiled under the
F"Project Job Aids folder.

> To minimize duplication, in lieu of adding job aids, user may review Job Aids under [ Project Job Aids
folder by clicking on the [Select] tab under ["1Job Aids folder, placing checkmarks next to the required
Job Aids and clicking [Save] to add under the Task or Performance Objective.
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Policies/Procedures

To identify policies and procedures needed to perform Tasks:

Step 1: Click on the FtPolicies folder.

Step 2: Click [Add].

Step 3: Input the policy title, description and other required information.
Step 4: Click [Save].

Uy

x Delete + Merge < Diverge (11 Notes < Restore ? Help Logout
Path Training Analysis b Project Management Office » Leadership b Developing Others b Set Course of Action b Policies
Dashboard Design Develop Implement Evaluate Solutions Documents Reports Personalize
4Training Analysis Policies
v [Projects

A et o Ensure the safety of employees, customers and equipment
» [3Mission Analysis Title™
v [ Competencies
v [ Leadership \ [r—
» I Tasks Reference Code Policy 350

) Performance Objectives
] Manage Learning Objectives
» =3Competency Reports
>Import Competency Tasks
* £ Competency Area « »
» [1Set Goals
v [7 Developing Others
¥ [ Tasks
v [ Set Course of Action
Training

- Knowledge/Skills
» [22Job Aids
Broice:
/ 2 Tools
F3Sub Tasks

» [ Set Targets
» [2Performance Objectives
~I Manage Learning Objectives
» 1Competency Reports
<>Import Competency Tasks

Sequence 0 ™

Click the Save button on the top left to save.

Note:

> Similarly, when a Policy is added, it is automatically compiled under the F}Project Policies folder.

> To minimize duplication, in lieu of adding policies, user may review Policies under [ Project Policies
folder by clicking on the [Select] tab under [}Policies/Procedures folder, placing checkmarks next to
the required Policies and clicking [Save] to add under the Task or Performance Objective.
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Tools

To identify tools needed to perform Tasks:

Step 1: Click on the ["#Tools folder.

Step 2: Click [Add].

Step 3: Input the tool title, description and other required information.
Step 4: Click [Save].

v U

x Delete © Merge % Diverge 1 Notes ? Help Logout
Path Training Analysis b Project Management Office » Leadership b Developing Others b Set Course of Action b Tools

Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis Tools
v [MProjects

+ [ Project Management Office ADVISOR' Personnel & Resources Software to forecast financial, personnel, equipment and resource requirements |
» )Mission Analysis Title*
v [Competencies
v [ Leadership \ "
» iTasks Reference Code Tool 090
[ Performance Objectives
“ Manage Learning Objectives el 4 L

» = Competency Reports
> Import Competency Tasks
v ™ Competency Area « .>
» [ Set Goals
v (7 Developing Others
v [ Tasks
¥ [ Set Course of Action
1 Training
22Knowledge/Skills

» 22Job Aids
» 2Policies
-
/ FSUb Tasks
» [ Set Targets

» [Performance Objectives
"I Manage Learning Objectives
» =iCompetency Reports
&>Import Competency Tasks

Click the Save button on the top left to save.

Note:

> Similarly, when a Tool is added, it is automatically compiled under the ["}Project Tools folder.

> To minimize duplication, in lieu of adding tools, user may review Tools under ["}Project Tools folder
by clicking on the [Select] tab under [ Tools folder, placing checkmarks next to the required Tools
and clicking [Save] to add under the Task or Performance Objective.
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2.5 Define Performance and Enabling Objectives

Tasks refer to activities that individuals are expected to perform within a competency. Although
individuals may require training on some Tasks in order to master, simpler Tasks with minimal impact may
not require any training. In general, Performance Objectives can be viewed as Tasks that require training.

Auto Generate Performance Objectives

To facilitate the creation of Performance and Enabling Objectives, Competency Tasks are presented under
the [Auto Generate] tab under the [ tPerformance Objectives folder. To create:

Step 1: Click on the [Auto Generate] tab.
Step 2: Place checkmarks next to Tasks that require training.

Step 3: Click [Save] to automatically generate the corresponding Performance Objectives under the [}
Performance Objectives folder. Sub Tasks are in-turn translated into Enabling Objectives. In
addition to cascading the attributes of each Task and Sub Task to the corresponding Performance
and Enabling Objectives, associated Knowledge, Skills, Job Aids, Policies and tools will also be
transposed.

Path Training Analysis » Project Management Office b Leadership b Developing Others b Performance O

+Add & Save ¥ Copy x Delete © Diverge (0} Notes H Print 1 Up W Restore ? Help X Logout
% 4

Dashboard Setup Scope Analyze A Develop Implement Evaluate Solutions Documents Reports Personalize
3 Training Analysis Performance Obje”tives
v Projects by s Aulo Generate Search Import E

v [ Project Management Office ° 6
» 3Mission Analysis
i /] SetCourse ofAction
v [ Leadership Set Targets ——
» [Tasks o 2 \

) Performance Objectives
Manage Leaming Objectives
» =1Competency Reports <‘ ’>
“Import Competency Tasks
v ™ Competency Area
» [ Set Goals
¥ [ Developing Others
¥ [ Tasks

» [} Set Course of Action
» [ Set Targets
8 crtomance Objectives |
S / Manage Leaming Objectives
» =3Competency Reports

<>Import Competency Tasks
» [2Job Analysis
Jobs Proficiency Levels
1Project Tasks
yTeam Knowledge/Skills
\Project Job Aids
Project Policies
[Project Tools.
)Project References
“Acronyms
» FProject Knowledge/Skills Attributes
» Project Reports
Search
» M1 Segments

Click and complete next tab, if applicable; then click the Save button on the top left to save.

vvw

Note:

> To preserve data integrity, should the Competency Task attributes change, they automatically cascade
to all corresponding Performance Objective attributes if the cascade option is turned on . You may
of course turn the cascade option off @, to make changes to the Performance Objective.
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Create New Performance Objectives

To add a new Performance Objective:

Step 1: Click on the F"tPerformance Objectives folder under the H (competency) node.
Step 2: Click [Add].

Step 3: Input the Objective Title, Standards, as well as other attributes.

Step 4: Next, click on the [Conditions], [Cues], [Certification] and [Tasks] tabs, and complete.
Step 5: Click [Save], when ready, to create the Objective.

¥ 4

+Add & Save & Copy x Delete * Merge < Diverge 11 Notes H Print 1 Up <« Restore ? Help X Logout
Path _Training Analysis b Froject Management Office b Leadership b Developing Ofhers b Performance Objectives
Dashboard efen Solutions Documents Reports Personalize
=1 Training Analysis Performance Objectives 1
v Projects Aftributes  Condiions Cues Certification Tasks
v [ Project Management Office
» [)Mission Analysis
¥ [2Competencies Objective Title"
v [l Leadership
» [Tasks
=3Performance Objectives Reference Code
Manage Leaming Objectives <
> :Compg:ency Rezons‘ e B 2
#Import Competency Tasks e 1
¥ [2Competency Area Standards -

» [ Set Goals e

v [ Developing Others
. » [Tasks Classification Individual ¥
ZisiPerformance Objectives Obi Classifi .
/ » [1Set Course of Action jective Classification [ select ] >
» [ Set Targets Task Proficiency Level

Manage Learning Objectives

» =iCompetency Reports Training Frequency
> Import Competency Tasks Training Time [hours] 0
» 22Job Analysis
Jobs Proficiency Levels Format of Assessment Theory .
» [Project Tasks Type of Assessment Summative ™
» 3Team Knowledge/Skills
» M Project Job Aids
3Project Policies Assessment Activity
P Project Tools
FProject References
2 Acronyms
» M Project Knowledge/Skills Attributes e Tl Rt aares
» S1Project Reports
Search
» I1Segments Impact of Failure
Notes:

> Obijective Priority and Training Requirements are dictated by Tasks and Sub Tasks that the Objective
supports —i.e., indicated under the Align Attributes with Task field. They are presented under the .

Training node under each H (objective).

> Sub Divide Objective: Performance Objective can also be divided into Enabling Objectives. Each
Performance Objective can only be assigned as a single unit (including all Enabling Objectives) to
a single Competency. In other words, if a Performance Objective is divided into Enabling Objectives
A and B, you cannot assign Enabling Objective A to Leadership Competency for example, and Enabling
Objective B to General Competency.

> Status: To facilitate data sharing and minimize effort required to analyze Objectives, a Search function
is provided to help analysts locate and copy existing Performance Objectives. Analysts can only search
for and copy Objectives (but not edit or delete) that are classified as Public under the Status field. If
the Performance Objective is classified as Private, it will not be accessible by the Search function.
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A\ 4

Search. To facilitate the analysis, a [Search] tab is also presented on the ["}Performance Objectives
folder. You can search for Performance Objectives by Mission, System, Competency, Job or Keyword.
To copy, place checkmarks next to the desired Performance Objectives and click [Save]. All Enabling
Objectives as well as Knowledge and Skills associated with the selected Performance Objectives are
also copied.

Y

If References have been defined under the [ ?Project References folder (Section 6.2 of Training
Analysis User Guide), a [Reference] tab will also appear after the [Certification] tab to link Objectives
to specific mandate, requirement, manual, etc. By establishing these links, in addition to documenting
the reasoning behind the Objective, analysts can quickly identify which Objectives (including
Knowledge, Skills and Attitudes) are affected — should there be a change in a specific mandate,
requirement or manual.

2.6 Uncover Knowledge and Skills Gaps

Define POs/EOs Knowledge/Skills

If the Performance Objective was created using the [Auto Generate] tab, then all associated KSAs of the
Task will be automatically copied to the F?Knowledge/Skills folder. Otherwise you can define the
required knowledge and skills for the performance objective as follows:

Step 1: Click on the " *Knowledge/Skills folder.

Step 2: Click [Add].

Step 3: Input the Knowledge/Skill Title, Learning Outcome, Classification and Knowledge/Skill Level.
Step 4: Click [Save].

v Y

+Add & Save ¥ Copy x Delete + Merge 4 Diverge 1 Notes H Print 1 Up « Restore ? Help X Logout
Path _Training Analysis ¥ Froject Management Office » Leadership b Developing Others b Set Targets b Valdate Ine viabilly of goals
Dashboard Setup Scope Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize

= Training Analysis
v [Projects
¥ [ Project Management Office
» 2)Mission Analysis
v Competencies
¥ [ Leadership
» [iTasks
[ Performance Objectives
Manage Leaming Objectives
» = Competency Reports
Import Competency Tasks
' [ Competency Area
» [ Set Goals
v (7 Developing Others
» [Tasks
v [Performance Objectives

Validate the viability of goals
Knowledge/Skill Meta Tag

bl )

Validate the viability of goals

Title”

Reference Code
Leaming Outcome*  Knowledge
Classification Procedure

Knowiedge/Skill Level Skilled

Sequence 200

Click and complete next tab, if applicable; then click the Save button on the top left to save.

» [1Set Course of Action 4 »

% [ Set Targets
) Knowledge/Skills
I Wiite clear and concise goals
Describe key elements of a goal

3Job Aids
M Policies
M Tools
Knowledge/Skill Gap
» [ Training
"I Manage Leaming Objectives
» =iCompetency Reports
&>Import Competency Tasks

Note:

» Once a knowledge or skill is defined, the H Knowledge/skills Gap node is presented under the [}
Performance Objectives folder to identify knowledge/skill gaps.
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Determine Knowledge/Skill Gaps

To identify knowledge and skill gaps:

Step 1: Click on the H Knowledge/Skills Gap node.
Step 2: Indicate the current knowledge and skill levels.
Step 3: Click [Save].

4

+Add & Save 15 Copy x Delete + Merge % Diverge 1 Notes H Print tUp <« Restore ? Help Logout
Path _Training Analysis b Project Management Office b Leadership b Developing Others b Set Targets b Knowledge/Skill Gap
Dashboard Develop Implement Evaluate Solutions Documents Reports Personalize
i Training Analysis Knowledge/Skill Gap
v [MProjects
¥ [ Project Management Office Knowledge/Skill Current Level Desired Level
* Ession Analysis Validate the viability of goals
v [Competencies
v [ Leadership [ select] v Skilled v
» [ Tasks
[ Performance Objectives
Manage Leaming Objectives Wit clear and concise goals
» £3Competency Reports =
| v il v
#Import Competency Tasks [select] Stkiled

v [Competency Area
» [1Set Goals
v [ Developing Others

» DTasks [ select ] v Skileg v
v [ Performance Objectives
» 71 Set Course of Action Basic
v [ Set Targets Semi-Skilled
» M Knowledge/Skills Click the Save button on the top left to save. Skilled —
7 Job Aids :;gpheitt Skilled @ »
EPolicies
2 Tools
—_— / » [ Training
1/ Manage Leaming Objectives

» S3Competency Reports
c>Import Competency Tasks

Describe key elements of a goal

Note

> If Desired level exceeds Current level, a Knowledge/Skill gap is identified; and a Learning Objective is

automatically created under the [ tLearning Objectives folder under the O Training node.

» The Knowledge/Skill background changes to green to indicate that a Learning Objective has been
setup to address the gap.

» To indicate how the Knowledge/Skill Gap will be addressed, click on the H Training node, and select
Formal Training, Workplace Training or Residual Training Gap.
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Define Learning Objectives

You may create multiple Learning Objectives (Teaching Points) to address a single knowledge/skill gap.
The Learning Objectives should specify the conditions under which knowledge and skills should be
exhibited, the standard to which it will be performed and reflect the gap between current and desired
level.

To indicate time needed to close the Knowledge/Skill Gap:

Step 1: Click on the H (learning objective) node under the FtLearning Objectives folder.
Step 2: Input the Length and edit the Title if required.
Step 3: Click [Save].

4

+Add & Save B Copy x Delete * Merge % Diverge 0 Notes H Print T Up % Restore ? Help Logout

Path Training Analysis » Project Management Office b Leadership » Developing Others b Set Targets b Training b Validate the viabilty of goals

Dashboard Implement Evaluate Solutions Documents Reports Personalize
1 Training Analysis [] ~g Validate the viability of goals £

v
L, Prcgeg:a Management Office Validate the viability of goals
» )Mission Analysis
v " Competencies
v [ Leadership

v eds Reference Code °
[ Performance Objectives
Manage Learning Objectives Length [hours] 05 4
% ;Compelency hiepars Leaming Outcome*® Knowledge — [
“>Import Competency Tasks

Leamning Objective® ©

v [ Competency Area Classification Procedure [
» [ Set Goals
Knowledge/Skill Level® Skilled
v [ Developing Others o
» [ Tasks Align Attributes with Knowledge/Skill Valigate the viability of goals v (%]

v [Performance Objectives
» [ Set Course of Action
v [ Set Targets Reference
» 3 Knowledge/Skills
=2Job Aids
™ Policies
2 Tools

Knowledge/Skill Gap Click the Save button on the top left to save.
L Training « ‘)
[:Leaming Objectives
.
» [ Wite clear and concise goals

» [ Describe key elements of a goal
" Manage Learning Objectives
» =1Competency Reports
>Import Competency Tasks

Sequence 200

Notes:

» Toadd anew Learning Objective (Teaching Point), click on the " Learning Objectives folder, and then
click [Add]. You will be prompted for the Learning Objective Title, Length, Learning Outcome,
Classification and Knowledge/Skill Level. Input the required fields and click [Save].

> Learning Objectives can be assembled in courses/training programs. Defining Learning Objectives is
therefore critical for establishing clear links between Training Programs, Objectives, Tasks, Jobs and
Competencies; demonstrating the value of various training programs, and aligning training with
organizational missions/goals.
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Chapter 3: Setup Jobs

3.1 Setup Jobs

To identify Jobs to be analyzed:

Step 1: Click on the FtJob Analysis folder.

Step 2: Click [Add].

Step 3: Input the Job Title, a brief overview as well as other relevant data.
Step 4: Click [Save] to create the job.

U U

+Add Save & Copy x Delete + Merge < Diverge (1 Notes H Print Tt Up « Restore ? Help [ Logout
Path Training Analysis b Project Management Office » Project Manager

Dashboard Setup Scope Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
=4 Training Analysis Ml Project Manager 250
¥ [Projects Attributes it Employees  Sharir

v [ Project Management Office

» [)Mission Analysis Job Title® Project Manager
g Conpetncs Reference Cade Job 021
v 3Job Analysis
/ [slProject Manager Status” Public \ =
» [ Online Manager Client* —

Corporate Training Division
Jobs Proficiency Levels

» P2Project Tasks Limit Access to Client”  Yes v
» I Team Knowledge/Skills Person in overall charge of the planning and execution of a particular project
» [)Project Job Aids
FProject Policies Sl
F2Project Tools
[P roject Refetences Generate Task Numbers (3
3 Acronyms
» [)Project Knowledge/Skills Attributes Move to Project Management Office v
» iProject Reports s
\Search Manager Administrator v
» [Segments Sequence 100
Click and complete next tab, if applicable; then click the Save button on the top left to save.

> To facilitate the analysis process, public Job Analyses (defined under Status field) are made available
to other users (analysts) under the [Search] tab. Users may copy relevant analysis (including tasks,
performance/enabling objectives, knowledge/skills, etc.) to their own projects. Note that making Job
Analysis Public does not imply that others can make changes to your analysis — it simply implies that
they can copy and reuse.

> The profile of each job, including financial data as well as instructional design characteristics that may
impact the effectiveness of alternate delivery media can also be specified in this section by clicking on

the LIFinancial Data, L. Characteristics, or LIAttitude nodes, completing relevant sections and
clicking [Save].
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3.2 Assign Competencies to Jobs

Step 1: Click on the H Jobs Proficiency Levels node.
Step 2: Select Jobs to be analyzed.
Step 3: Click [Save].

Save 8 Copy = Delete * Merge % Diverge 1} Notes tUp  Restore ? Help Logout
Path Training Analysis b Project Management Office » Jobs Proficiency Levels

Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize
=i Training Analysis Jobs Proficiency Levels
¥ [Projects

v [ Project Management Office
» [Mission Analysis Project Manager
» i-Competencies Online Manager
» 2Job Analysis \ —
/ » [Project Tasks
» [ Team Knowledge/Skills Select items to be included in the table; then click on the Save button on the top left to display.
» 3Project Job Aids
F3Project Policies
Project Tools
Project References
P2 Acronyms
» E2Project Knowledge/Skills Attributes
» =1Project Reports
Q Search
» Segments

Competencies and Competency Areas created under the F*Competencies folder (Section 2.2) are
presented in the 1°* column and the Jobs in the 1% row. To indicate the level of competency required by
each Job:

Step 4: Click on the desired cell to display a dropdown menu, and select the desired level.
Step 5: Once the competency requirements for all Jobs have been defined, click [Save].

Y.

Save = Reload
Systems Project Manager  Online Manager h
Leadership " skilled " Skilled \ rm—
Set Goals 7 Skilled " Semi-skilled
Developing Others "highly Skiled | Skilled
General " skilled " skilled
Conflict Management "Highly Skiled  Semi-Skilled
Al riccbiity :Shlled .'Semt-Srkllled o
Initiative Skilled [select] ‘ V-
>[Vselect]w '
Basic \ pr—
Semi-Skilled
Skilled
Highly Skilled
Expert

Save Reload
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Chapter 4: Generate Reports

One of ADVISOR's key benefits is the easy and speed in which various types of reports can be generated,
for project, systems/competencies and jobs. Several reports are discussed below.

4.1 Tasks Report

Generates a concise list of Tasks, Sub Tasks, Steps and Sub Steps for each System/Competency including
training requirement and priority, as well as prerequisite Knowledge and Skills. To generate Tasks Report:

Step 1: Click on the [ Task List Report node under the tCompetency Reports folder.

i Save B Copy x Delete * Merge % Diverge [ Notes T Up . Restore ? Help Logout
Path_Training Analysis b Project Management Office b Leadership b Developing Others b Competency Reports b Tasks Report
Dashboard Scope Design Develop Implement Evaluate Solutions Documents Reports Personalize
5 Training Analysis - Tasks Report
v [2Projects
¥ [ Project Management Office
» [)Mission Analysis
v [2Competencies
v [ Leadership
» [Tasks
™ Performance Objectives
~1 Manage Learning Objectives
» =1Competency Reports
coImport Competency Tasks
w ™ Competency Area
» [ Set Goals
¥ [ Developing Others
» [Tasks
» [Performance Objectives
Manage Leaming Objectives
= Competency Reports
B
—_ [ Performance Objectives Report
[ Training Requirements Analysis Report
[ Align Tasks with Training Report
>Competency Tasks Scalars
<»Competency Objectives Scalars
[ Competency Analysis Report
[ Competency Requirements Report
[ Training Plan Report
[ Qualification Plan & Standards Report
<>Import Competency Tasks
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Step 2: You may export the report to Excel, by clicking the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window.

|Generate Excel|

System
Prepared by: Administrator

Developing Others

Date: 02 July 2020 01:26 PM

RNH

EXPERT SOFTWARE

[ vasks

S T

Set Course of Action

Prioritize Actions

Direct Staff

Monitor Personnel & Resources
Set Targets

Create Action Plan
Evaluate Results

Forecast Personnel & Resource Requirements.

Tasks Report

Train High
Train High
Train High
Train High
Train High
Train High
Train High
Train High

Identify Market Segments Knowledge
Describe key elements of a goa Knowledge
Validate the viability of goals Knowledge
Write clear and concise goals Knowledge
Implement incentive system Knowledge
Measure employees engagement Knowledge
Describe key elements in a core value | Knowledge

Communicate importance of core values Knowledge

Validate the viabilty of goals Knowledge
Wite clear and concse goals Knowledge
Implement incentive system Knowledge
Implement safety system Knowledge
Measure employees engagement Knowledge
Measure management engagement  Knowledge
Calculate Personnel Utiization Knowledge
Prioritize Tasks Knowledge
Estimate Facilities Costs Knowledge
Estmate Personnel Costs Knowledge
Estimate Development Effort Knowledge
Analyze Risks Knowledge
Prioritize Risks Knowledge
Mitigate High Risks Knowledge
Contingency Plan Knowledge
Estimate Benefits and ROT Knowledge
Describe key elements of 2 goa Knowledge

Skilled
Skilled
Skilled
Skilied
Skilled
Skilled
Skilled

Knowledge/Skills Learning Outcome|Knowledge/Skill Level|

www.bnhexpertsoft.com
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4.2 Performance Objectives Report

Generates a concise list of Performance and Enabling Objectives for each System/Competency including
prerequisite Knowledge and Skills and Training Requirements. To generate Performance Objectives
report:

Step 1: Click on the [ performance Objective Report node under the f*Competency Reports folder.

& Save ¥ Copy x Delete + Merge < Diverge 1} Notes ftUp « Restore ? Help Logout
Path _Training Analysis » Project Management Office  Leadership b Developing Others b Competency Reports b Performance Objectives Report
Dashboard Setup Scope Analyze Design Develo
[4Training Analysis a Performance Objectives Report
v iProjects
v [ Project Management Office
» 3Mission Analysis
v P Competencies
v [ Leadership
» MTasks
2 Performance Objectives
~1 Manage Leaming Objectives
» =3Competency Reports
&> Import Competency Tasks
v 3Competency Area
» [ Set Goals
¥ [ Developing Others
» [ Tasks
» )Performance Objectives
Manage Learning Objectives
v [=1Competency Reports
[ Tasks Report
0
- [ Training Requirements Analysis Report
[ Align Tasks with Training Report

Implement Evaluate Solutions Documents Reports Personalize

[y Competency Analysis Report

[ Competency Requirements Report

[ Training Plan Report

[ Qualification Plan & Standards Report
&>Import Competency Tasks

Step 2: You may export the report to Excel, by clicking the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window.

[Generate Excel
\ Performance Objective Report

System. Developing Others
Srepared by: Administrator
Date: 02 July 2020 01:24 PM

Performance Objective| Enabling Objective
Set Course of Acticn = vigh Fermal Taining

T : e

T T T T e

e : E
T ——y
Knowledge Train High
e [ — s
e
e
e
e
S
Etrr—rrm

Training Allocation] Classification] Priority

Describe key elements of  goal Formal Training | Procedure | High
Valdats the viabilty of goals Formal Training | Procedure | High
Writs clear and concise goals Formal Training | Procedure | High
Identy Market Segments Formal Training | Procedure | High
Implement incantive system Workplace Training _ Procedure | High
Meas, Workplacs Training | Procedure | High

Describs key elements in 2 cors valus
Communicats importance of core valuss
Prioritzs Tasks

Estimate Development Effort

olace Training | Procedure | High
Procedure | High

Fact High
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4.3 Training Requirements Analysis Report

Generates the training requirements for each Competency and Competency Area, including the
Knowledge, Skills and Attitudes needed by each Performance and Enabling Objective, their classification,
as well as Entry and Desired Competency Levels and Gaps. To generate Training Requirements Analysis
Report:

Step 1: Click on [ Training Requirements Analysis Report node under FF}*Competency Reports folder.

+Add & Save ¥ Copy x Delete * Merge < Diverge 11 Notes B Print 1 Up % Restore ? Help Logout

Path Training Analysis b Project Management Office b Leadership b Developing Others » Competency Reports » Training Requirements Analysis Report

Dashboard Scope Analyze Develop Implement Evaluate Solutions Documents Reports Personalize

¥ LaFrojects - Training Requirements Analysis Report
v [ Project Management Office
» ) Mission Analysis
v " Competencies
v [ Leadership
» ETasks
[ Performance Objectives
Manage Learning Objectives
» £3Competency Reports
c>Import Competency Tasks
v [2Competency Area
» [ Set Goals
v [ Developing Others
» [3Tasks
» [2Performance Objectives
Manage Learning Objectives
v [Competency Reports
[ Tasks Report
erformance Objectives Report
lign Tasks with Training Report
Competency Tasks Scalars
<>Competency Objectives Scalars
[ Competency Analysis Report
") Competency Requirements Report
[ Training Plan Report
") Qualification Plan & Standards Report
&>Import Competency Tasks

Step 2: You may export the report to Excel by clicking on the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window.

[Generate Excel

Training Requirements Analysis Report

System: _ Developing Others
Prepared by: Administrator
Date: 02 July 2020 01:47 PM

| Performance Objective|Enabling Objective Knowledge/Skills Reference Code|Learning Outcome| Classification |Entry Level | Desired Level|Gap!
Set Course of Action Lead-02-001
Describe key elements of a goal KSA 209 Knowledge Procedure Skilled 3
it iiien i Identify Market Segments KSA 231 Knowledge Procedure Skilled 3
Virite clear and concise goals KSA 005 Knowledge Procedure. skilled 3
Validate the viability of goals Ksa 259 Knowledge Procedure. Skilled 3
Prioritize Tasks KSA 421 Knowledge Fact skiled 3
Measure employees engagement KSA 400 Knowledge Procedure Skilled 3
Direct Staff Lead-02-001-002 Communicate importance of core values KSA 112 Knowledge Procedure. Skilled 3
Implement incentive system KSA 108 Knowledge Procedure skilled 3
| Describe key elements in a core value  KSA 404 Knowledge Procedure Skilled 3
| Estimate Facilities Costs KSA 504 Knowledge Fact Skilled 3
Estimate Development Effort KSA 088 Knowledge Fact skilled 3
Calculate Personnel Utilzation KSA 119 Knowledge Fact skiled 3
Monitor Personnel & Resources Lead-02-001-003 Estimate Benefits and ROT KSA 018 Knowledge Fact Skilled 3
Estimate Personnel Costs KSA 555 Knowledge Fact Skalled 3
Measure employees engagement KSA 154 Knowledge Procedure. Skilled 3
| Measure management engagement  KSA 099 Knowledge Procedure L 3
| Describe key elements of a goal KSA 105 Knowledge Fact 3
Set Targets Lead-02-002 Validate the viabiity of goals Knowledge Procedure. L 3
Virite clear and concise goals Knowledge Procedure. skilled 3
Calculate Personnel Utilzation KsA 119 Knowledge Fact Skiled 3
Estimate Facilties Costs KSA 604 Knowledge Fact Skilled 3
Forecast Personne! & Resource Requirements  Lead-02-002-001 Estimate Personnel Costs KS4 555 Knowledge Fact Sklled 3
Measure employees engagement KSA 154 Knowledge Procedure. Skilled 3
Measure management engagement  KSA 099 Knowledge Procedure Skilled 3
Analyze Risks Knowledge Fact Skilled 3
Prionitze Risks Knowledge Fact Skalled 3
Create Action Plan Lead-02-002-002 Implement safety system Knowledge Procedure Skilled 3
Validate the viability of goals. KSA 299 Knowledge Procedure Skilled 3
Implement incentive system Knowledge Procedure. skilled 3
| Analyze Risks Knowledge Fact Skilled 3
o s Contingency Plan Knowledge Fact skilled 3
Evaluste Resuls Lead02:002:003 Mitigate High Risks Knowledge Fact Skilled 3
Prioritize Risks Knowledge Fact skilled 3

Note:
» Training Requirements (highlighted in green) are identified when the Desired Knowledge/Skill/
Attitude Level exceeds Current Knowledge/Skill/Attitude Level.
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4.4 Align Tasks with Learning Objectives Report
To generate audit report and validate that all requirements have been adequately addressed. In other

words, how and where the requirements of each Task or Performance Objective are being addressed. The
reports may also be used to find out how teaching points have been derived. To generate:

Step 1: Click on O Align Tasks with Training Report node under the FF*Competency Reports folder.

Step 2: Select which audit report you wish to generate, for example the Align Tasks with Learning
Objectives.

Step 3: Click [Save] to generate.

& Merge

x Delete % Diverge 1} Notes Tt Up « Restore ? Help X Logout

Analyze Design Evaluate Solutions Documents Personalize

- Align Tasks with Training Report

Develop

Implement Reports

v [ Project Management Office

» [)Mission Analysis ® Align Tasks with Learning Objectives
v [-3Competencies N ———
v " Leadership Align Objectives with Learning Objectives
> DiTasks ) Leaming Objectives Media and Time
2 Performance Objectives
Manage Leaming Objectives O Learning Objectives Current Media and Time

» 3Competency Reports
c>Import Competency Tasks
v Competency Area
» [ Set Goals
v [ Developing Others
» [Tasks
» Performance Objectives
I Manage Learning Objectives
¥ =Competency Reports
[ Tasks Report

Select sections to be included in the report; then click on the Save button on the top left to generate a report.

[ Performance Objectives Report

[ Training Reguirements Analysis Report

Blaign Tasks with Training Report |
/ <>Competency Tasks Scalars

<>Competency Objectives Scalars

[ Competency Analysis Report

[ Competency Requirements Report

[1Training Plan Report

[ Qualification Plan & Standards Report
“>Import Competency Tasks

Note:

» The results are presented in a Tabular format.
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Step 4: You may export the report to Excel, by clicking the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window.

System: Developing Others
Prepared by:
Dat

dministrator

02 July 2020 04:12 PM

Align Tasks with Learning Objectives

= = Training Performance/Enabling Knowledge/Sk asison Co
Requirement Objoctive

BRNH

EXPERT SOFTWARE

www.bnhexpertsoft.com
Copyright © BNH Expert Software Inc.

Set Codrse of Teain Set Caursa of Action al Training
Action ¢
Tdantify Market Segments Tdentify Market Segments Market Project
Analysis | Management
Mar ofect
Describe key elemants of 3 goal | Yes | Describe key slements of 2 goal | M1arket Project
Analysis | Management
Train Frioritize Actions Formal Tralning —= e
Validate the viability of goals | Yes | Validate the viability of Market Profect
: Analysis | Management
Write clear and concisa goals | Yes | Write dear and concise goals | Tiarket Project
Analysis | Management
Implement incontive system a5 | Implement incontive system | H2 ket Profect
Analysis Management
Measure emoloyees yoe  Measure emoloyees Market Profect
engagement engagement Analysis  Management
s Frm—— Workplace Describe key elements in 2 core | Describe key elements In 2 core Market Project
Training ¥ value Analysis | Management
Communicate importance of |, Communicate Importance of  Market Project
core values core values Analysis | Management
Harket Project
prioritize Tasks o5 | Prioritize Tasks <
TIOAZe e b el Analysis | Management
HMeasure employees yes | Measure employees Cost Project
engagement engagement Analysis | Management
Measure management Yes | Measure management c Project
engagement engagement Analysis | Management
e P i x Project
Calculate Personnel Utilization | Yes  Calculate Personnel Utilization - 4
a & Analysis  Management
. i . - > ost ject
Monitor Personnel & Resources Train Moritor Personnel & R #ormal Training | Estimate Fadiities Costs yes ate Fadlities Costs g;aw” f"a"";ﬁmw
. Cost Project
imate Personnel C Yes | Estimate Personnel
Estimate Personnel Costs es  Estimate Personnel Costs analysls: |Management
5 . 3 Project
imate Development Effo ¥ mate Development Effo: Y
Estimate Development €ffort | Yes | Estimate Development €ffort | p2 o | QUECL
. . Cost Project
im: enefi ROI Y m nefits and Ri A 4
Estimate Benefits and RO es  Estimate Benefits and ROI aaslyils. |Manapemenk
K ity of Z 7 Cost Project
Validate the viability of goals | Yes vValidate the viability of goals
ralidate the viability of g s Validate the wiability of go: Analysis Management -
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4.5 System/Competency Analysis Report

To generate a comprehensive report for each system/competency including tasks, performance/enabling
objectives, learning objectives, training requirements and attributes:

Step 1: Click on the O System/Competency Analysis Report node under the FFiSystem/Competency

Reports folder.

Step 2: Select items to be included by placing checkmarks next to the desired sections.

Step 3: Click [Save].

4

+Add & Save

13 Copy

Dashboard
IProjects
v [ Project Management Office
» Mission Analysis
v " Competencies

Setup Scope

x Delete
Path Training Analysis ¥ Project Management Office » Leadership b Developing Others b Competency Reporls b Competency Analysis Report
Analyze

- Competency Analysis Rgf it
® Inciude Hidden Fields
2 Exclude Hidden Fislds
Report

* Merge 4 Diverge 1 Notes

Design Develop Implement

H Print

Evaluate

TUp w Restore ? Help X Logout

Solutions Documents Personalize

¥ || Leadership
» Tasks [ Tasks
2 Performance Objectives & Training
Manage Leaming Objectives B KnowledgerSkilis
» =3Competency Reports (O Job Aids
“>Import Competency Tasks ([ Policies
v [Competency Area [ Tools
> [ Set Goals Performance Objectives
v [ Developing Others B Knowledgerskilis
» [iTasks 5 Job Aids [p—
» [Performance Objectives [Poiicies
Manage Learning Objectives [ Tools
v [~Competency Reports [Training
Bslc Regat Select sections to be included in the report; then click on the Save button on the top left to generate a report.

[ Performance Objectives Report
[ Training Requirements Analysis Report
[ Align Tasks with Training Report

“>Competency Tasks Scalars
<»Competency Objectives Scalars
[BICompetency Analysis Report

[ Competency Requirements Report
[ Training Plan Report

[ Qualification Plan & Standards Report
&>Import Competency Tasks

Notes:

> If Exclude Hidden Fields is selected, all hidden fields will not be included in the report.

> Since the report is in html format, you can quickly advance to any section by clicking on the
corresponding title in the Table of Contents. You may print or save the report using the corresponding
functions in your Browser. To return to ADVISOR, close the Report window.
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4.6 Systems/Competency Report

To generate the Systems/Competency Report:

Step 1: Click on (3 Systems/Competency Report node under the [ Project Reports folder.
Step 2: Select items to be included by placing checkmarks next to the desired sections.
Step 3: Click [Save].

+Add Save ¥ Copy = Delete * Merge % Diverge 1} Notes H Print T Up  Restore ? Help & Logout

Path Training Analysis b Project Management Office » Project Reports » Competency Report
Dashboard Analyze Design Develop Implement Evaluate Solutions Documents Reports Personalize

5 Training Analysis Competency Report
¥ [MProjects
¥ [l Project Management Office

» [)Mission Analysis Competency
» 2Competencies Overview
» 2Job Analysis Indicators of Competence
Jobs Proficiency Levels Knowledge/Skills \ —

» [Project Tasks
» 3 Team Knowledge/Skills
» M Project Job Aids
» [Project Policies Select items to be included in the report; then click on the Save button on the top left to generate.
[ Project Tools
» [MProject References
Acronyms
» Project Knowledge/Skills Attributes
* [1Project Reports
[ Master Task List Report
() Master Training Task List Report
") Goals Top Down View Report
[ Goals Bottom Up View Report
[ Common KSA Report
[ TNA Report
lcompetency Report ]
" Job Competency Report

/ ) Search

» [)Segments

Step 4: You may export the report to Excel by clicking on the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window.

|Generate Word Doc|
\ Competency Report

Project: Project Management Office
Prepared by: Administrator
Date: 14 July 2020 10:36 AM

Set Goals. Set target goals and measure achievements
Identify Market Segments
Implement incentive system
Describe key elements of  goal
Validate the viability of goals
Virite clear and concise goals
Implement incentive system
Measure employees engagement
Describe key elements in  core value
Communicate importance of core values
Validate the viability of goals
Virite clear and concise goals
Implement safety system
Messure management engagement
Measure employees engagement
Calculate Personnel Utiization
Priontize Tasks
Estimate Facilities Costs
Estimate Personnel Costs
Estimate Development Effort

Leadershi . 5o A
® | Developing Others | Provide quidance, direction, contral and management 3 o e

Mitigate High Risks
Contingency Plan
Estimate Benefits and ROT
Describe key elements of 2 goal
Describe various venues for motivating employees|
Assess best venue for motivating employees
Assess best venue for motivating managers
Measure management engagement
Measure employees engagement
Prioritize Customer Needs

ess best venue for motivating employees
Identify Customer Needs
Prioritize Customer Needs

Conflict Management Analyze conflicts and apply necessary interventions, in line with policies and procedures, in order to resolve issues. » Resolve Conflict

Flexibility Ensure flexibility in approach, style and management to meets varied needs « Adjust Market Strategy

Mitigate High Risks

Contingency Plan

Identify Market Segments

Describe key elements of a goal

Implement incentive system

Measure employees engagement

Describe key elements in a core value
municate importance of core values.

Validate the viability of goals

wirite clear and concise goals

Measure management engagement

Measure employees engagement

Celculate Personnel Utilization

Prioritize Tasks

Estimate Facilties Costs

Estimate Personnel Costs

General

o Set Course of Action

Initiative Take initiative throughout the organization in order to help peers development and better meet dlient needs T CreE e s e
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4.7 Job System/Competency Report

To generate the Job System/Competency Report:

Step 1: Click on 3 sob System/Competency Report node under the [ tProject Reports folder.
Step 2: Select Jobs to be included by placing checkmarks next to the desired items.
Step 3: Click [Save].

“ 5"
+Add Save & Copy x Delete + Merge 4 Diverge 11 Notes H Print tUp « Restore ? Help & Logout
Path Training Analysis b Project Management Office » Project Reports » Job Competency Report

Dashboard Design Develop Implement Evaluate Solutions Documents Reports Personalize

=9Training Analysis
¥ [Projects
v [ Project Management Office
» E2Mission Analysis
» " Competencies
» 3Job Analysis
Jobs Proficiency Levels
» [)Project Tasks
» [3Team Knowledge/Skills
» IProject Job Aids
E2Project Policies
I Project Tools
» [Project References
) Acronyms
» FProject Knowledge!/Skills Attributes
¥ [SiProject Reports
") Master Task List Report
[ Master Training Task List Report
[ Goals Top Down View Report
[ Goals Bottom Up View Report

Job Competency Report

Project Manager
Online Manager

Select items to be included in the report; then click on the Save button on the top left to generate

[ Common KSA Report

[ TNA Report
[ Competency Report
o
— /5 Search
» 1Segments

Step 4: You may export the report to Excel by clicking on the [Generate Excel] button (top left corner). To
return to ADVISOR, close the Report window

Generate Excel| @

Project: Project Management Office

Job Competency Report

Prepared by: Administrator
Date: 08 July 2020 01:29 PM

Competency| Competency Area |Project Manager|Online Manager

Leadership Skilled Skilled
Set Goals Skilled Semi-Skilled
Developing Others Highly Skilled Skilled

General Skilled Skilled
Conflict Management  Highly Skilled Semi-Skilled
Flexibility Skilled Semi-Skilled
Initiative Skilled Skilled

Remember that context sensitive help is also available for each screen by clicking on [Help] and video clips

on how to perform specific functions by clicking on the video & icon.

Enjoy!
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